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About
 

CleanUp is a maintenance utility that allows you to find and remove records. You can find bibliographic records
without holding records, find holding records without bibliographic records, and delete records by barcode.
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How to use

 
To use the CleanUp utility:
 
1.      In your M3 directory, double-click CleanUp.exe (the default path is C:\Program Files\Mandarin M3).
This displays the CleanUp window (Figure 1).
 
FIGURE  1

 
Note: The name of the ISN box changes according to the function  you choose.
 
2.      In the Active Database list, select the database you want to search.
 
3.      In the Functions group, select an option: Find Holdings without  Bibs, Find Bibs without Holdings,
or Delete Record by Barcode. These functions are explained in the following sections.
 
 
Finding Holding Records without Bibliographic Records
1.      In the Functions group, click Find Holdings without  Bibs. The utility searches for holding records
without bibliographic records. This may take a while.
 
2.      If records are found, their ISNs appear in the Holding  ISN box. You can select an ISN to display the
full MARC record in the MARC Record box (Figure 2).
 
FIGURE  2
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Tip: To  change the MARC field labels from numbers to text, right-click in the MARC Record  box, then click Toggle Prompts.
 
3.      You can save record information to a file and delete or purge records.

•     To save the record’s barcode and call number, click the record in the Holding  ISN box, then
click Save Info. This displays the Save As dialog box. Navigate to the desired location, type a name
for the file in the File name box, and then click Save. This saves the information in text format.
•     To delete records, click DELETE records, then:
•     To delete one record, click the record in the Holding ISN box, then click Delete Record. This
marks the record for deletion.
•     To delete all records listed in the Holding ISN box, click Delete All. In the confirmation dialog
box, click OK. This marks the records for deletion.
•     To purge records, click PURGE records,  then:
•     To purge one record, click the record in the Holding ISN box, then click Purge Record. This
deletes and purges the record.
•     To purge all records listed in the Holding  ISN box, click Purge All. In the confirmation dialog
box, click OK. This deletes and purges the records.

 
 
Finding Bibliographic Records without Holding Records
1.      In the Functions group, click Find Bibs without  Holdings. The utility searches for bibliographic
records without holding records. This may take a while.
 
2.      If records are found, their ISNs appear in the Bibliographic ISN box. You can select an ISN to display
the full MARC record in the MARC Record box (Figure 3).
 
FIGURE  3
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Tip: To  change the MARC field labels from numbers to text, right-click in the MARC Record  box, then click Toggle Prompts.
 
3.      You can save record information to a file and delete or purge records.

•     To save the record’s call number, title, and author, click the record in the Bibliographic ISN box,
then click Save Info. This displays the Save As dialog box. Navigate to the desired location, type a
name for the file in the File name box, and then click Save. This saves the information in text format.
•     To delete records, click DELETE records, then:
•     To delete one record, click the record in the Bibliographic ISN box, then click Delete Record.
This marks the record for deletion.
•     To delete all records listed in the Bibliographic ISN box, click Delete All. In the confirmation
dialog box, click OK. This marks the records for deletion.
•     To purge records, click PURGE records,  then:
•     To purge one record, click the record in the Bibliographic ISN box, then click Purge Record.
This deletes and purges the record.
•     To purge all records listed in the Bibliographic ISN box, click Purge All. In the confirmation
dialog box, click OK. This deletes and purges the records.

 
Note: If you want to delete barcodes that were previously saved to a file,  skip  this  step.
 
Deleting a Record by  Barcode
1.      In the Functions group, click Delete Record by Barcode. This displays a dialog box explaining this
function. Click OK.
 
2.      In the Delete Record by Barcode box, type or scan the barcode, then click Enter Barcode. This
places the barcode of the record in the Barcode box (Figure 4). Repeat this step for each record you want
to delete.
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FIGURE  4

 
Tip: To  change the MARC field labels from numbers to text, right-click in the MARC Record  box, then click Toggle Prompts.
 
3.      You can open a previously saved barcode file, save barcodes to a file, save record information to a
file, and delete or purge records.

•     To open a barcode file, click Open BC File. This displays the Open dialog box. Navigate to the
location of the barcode file and click Open. This lists the barcodes in the Barcode box, ready to be
deleted or purged.
•     To save the barcodes listed in the Barcode box to a file, click Save Bar- codes. This displays
the Save As dialog box. Navigate to the desired location, type a name for the file in the File name
box, and then click Save. This saves the list in text format.
•     To save the record’s barcode, call number (of the holding), title, and author, click Save Info. This
displays the Save As dialog box. Navigate to the desired location, type a name for the file in the File
name box, and then click Save. This saves the information in text format.
•     To delete records, click DELETE records, then:
•     To delete one record, click the record in the Bibliographic ISN box, then click Delete Record.
This marks the record for deletion.

 
Note:  You can only save the list of ISNs  if you have not deleted all the records in the list.
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Generating Barcode Labels
 

M3 includes a Barcode Labels utility that allows you to create and print barcodes for items in your collection.
 
1.      On the taskbar, click the Start button, select Programs, select Mandarin M3, select Utilities, and then
click Barcode Labels. This displays the Barcode Labels window (Figure 2).
 
FIGURE  2

 
Tip: You can change the font size of the printed labels by clicking 36 or 26 in the Font  Size  box.
 
2.      In the upper pane, select the Avery label you want to use, then type the library name you want to appear
on the printed barcode.
 
Note: If 852#p does not appear in the record, add it. Right-click in the record,
select Insert Field, select 852, then click OK.  Then  select p and click OK.
 
3.      In the first barcode box (shown in Figure 2), type the first barcode in the sequence, and then click
Create. This fills each of the barcode boxes with a barcode based on your first entry incremented by +1.  For
example, if you type 1000, then next entry will be 1001, then 1002, and so on.
 
4.      If you want to preview the barcode labels, click Screen in the Print To box, then click the Print button.
When you are ready to print the labels, click Printer in the Print To box, then click the Print button.
 
5.      You now need to assign a barcode to each textbook holding record. To do so, search for the holding
record in the Cataloging module. When it dis- plays in the main window, double-click it. The record now
displays in the lower pane of the Holding - Cataloging window (see Figure 3). Click in field 852#p and then
scan the holding’s barcode with your barcode scanner. The barcode will appear in the 852#p  field. Click Save
in the holding window and repeat for each holding.
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Using Textbook database in M3
 
In M3, you can use your textbook database as you would your library database: you can catalog, circulate,
search for, generate reports for, inventory, and perform other functions with your textbooks.
 
Using the  M3  OPACs
To search your textbook database in the Windows OPAC or Web OPAC:
 
1.      On the Databases tab, select the check box next to the textbook database. Clear the check box next
to any database you do not want to search.
 
2.      Click Apply.
 
3.      Click the Search tab and conduct your search.
 
Using M3  Cataloging
Once textbook records are in your M3 database (created or imported through the Cataloging module), you
can perform all textbook cataloging functions including adding, editing, and deleting data.
 
To access the textbook database in Cataloging:
 
1.      On the File menu, click Change Database. This displays the Change Data- base dialog box.
 
2.      In the Current Database list, select the textbook database, and then click OK. You can now perform
all cataloging functions in this database.
 
TIPS:
•     In the holding record, use the 995#a field to enter a textbook’s condition. The default choices are New, Good, Fair, Poor, and
Unusable.
•     In the patron record, use the 852#b field to enter each student’s homeroom or the 852#c field to enter each student’s teacher.
You can then check out textbooks by class; to do so, perform a search for the homeroom teacher in Circulation (selecting
Homeroom or Teacher in the drop-down list in the Patron Search dialog box) to obtain a list of all students in the class, allowing
you to check out a textbook to each student.
•     In the holding record, use the 852#9 field to record each textbook’s price. This will be the amount of the fine if the item is lost by
the stu- dent.
 
Adding Holdings to Textbook Records
The Cataloging module makes it easy for you to add multiple holdings to a text- book record.
 
1.      Search for the bibliographic record of the textbook you want to add hold- ings to. You search results
appear in the upper pane of the main Cata- loging window.
 
2.      Click the bib record in the upper pane. Then do one of the following:

•     If a holding record similar to the one you want to create appears in the lower pane, use this as a
template. Click the holding record, then click Duplicate on the Edit menu.
•     If no similar holding record exists, select New on the File menu, and then click Holding Record.
(If more than one holding template is avail- able, the Templates dialog box displays. Click the
desired template, then click OK.) This displays the new holding record in the Holding - Cataloging
window (Figure 3).
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FIGURE  3

 
Note: The prefix and suffix values are assigned in 852#p.
 
3.      In the lower pane, enter field and subfield data for the holding records.
 
4.      Select the Generate Holdings check box. This activates the boxes below.
 

A.     In the Quantity box, type the number of holdings you want to add.
B.     If the record’s barcode has a prefix, it appears in the BC Prefix box. Modify if desired. If the
barcode does not have a prefix and you would like to add one, type a value in the BC Prefix box.

 
NOTE: This number is in addition to the holding records that already exist for this bibliographic record.
 
Tip: The available conditions are New, Good, Fair, Poor, and Unusable.
 

C.     The barcode suffix appears in the Start box. Modify if desired. The suffix must be a numeric
value and will be the starting value for the barcodes of the new holding records.
D.     In the + box, type the number for the suffix to increment by. For example, if the values are
1000  in the Start box and 2 in the + box, the first holding record will be assigned a barcode of
[Prefix]1000 and the next holding record will be assigned [Prefix]1002.

 
5.      When finished, click Save. (NOTE: If a barcode you chose already exists, an error message displays
and no holdings are created. Click OK and modify the value in the Start and/or + box, then click Save
again.)
 
Using M3  Circulation
You can perform all textbook circulation functions including check out/check in, renewals, viewing status,
adding student fines, recording condition of books, and reporting books as lost.
 
To use the textbook database in Circulation:
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1.      On the File menu, click Change Database. This displays the Change Data- base dialog box.
 
2.    In the Current Database list, select the textbook database, and then clickOK. You can now perform all
circulation functions in this database.
 
Several common procedures are described in the following sections. Instructions for all circulation functions
are available in Chapter 5, “Using M3 Circulation,” in the M3 Users Guide.
 
Checking out a Textbook to a Student
1.    On the Circulation toolbar, click Loan.
 
2.      If you are using a barcode scanner, scan the student’s barcode, then scan the barcode of each
textbook you want to loan to this student.

OR
A.     In the Barcode box, type the student’s barcode, and then press ENTER.
B.     In the Barcode box, type the textbook’s barcode, and then press ENTER. Repeat this step for
each textbook you want to loan to this student.

 
The textbooks are now loaned.
 
Checking in a Textbook from a Student
 
1.    On the Circulation toolbar, click Return.
 
2.    If you are using a barcode scanner, scan the textbook’s barcode.

OR
 
In the Barcode box, type the textbook’s barcode, and then press ENTER.
 

3.    The textbook is now returned. To record the textbook’s condition:
A.     Right-click in the pane where the textbook’s data appears (the pane on the right). In the menu,
click Edit.
B.     In the Edit Holding Record window, look near the bottom of the window for the field titled
Condition (field 995).

 
If the Condition field does not appear, add it. Right-click in the record and select Insert Field. In the
Insert Field dialog box, select 995-Condi- tion, then click OK. In the Insert Subfield dialog box, select a-
Condition, then click OK. The field now appears.
 

C.     Click the arrow next to the Condition field on the right side of the window. In the list, select the
desired condition, then click OK in the Edit Holding Record window.

 
Viewing the Status of a Student or Textbook
1.      On the Circulation toolbar, click Status.
 
2.      If you are using a barcode scanner, scan the student’s or textbook’s bar- code.

OR
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In the Barcode box, type the student’s or textbook’s barcode, and then press ENTER.
 
3.      The status of the student or textbook appears in the window; any open transactions are listed in the
lower pane.
 
Using the  Reports
The Textbook Enabler CD includes a report pack of 20 textbook-related reports, which you can generate
using ReportTool. To download these reports:
 
1.      Insert the Textbook Enabler CD into the workstation’s CD-ROM drive.
 
2.      Navigate to the CD-ROM drive (D: on most computers) and double-click TextbookReportPack.exe.
 
3.      In the Location to Save Files dialog box, accept the default location or enter another location. (To
browse to another location, click Change. Navigate to the desired folder, then click OK.) Click Next.
 
4.      When the report download is complete, click Finish. You can now generate these reports in
ReportTool.
 
Reports Included in the Textbook Report Pack
•     Fine-List(ByGrade&Patron)
•     Fine-List(ByHomeroom&Patron)
•     Fine-List(ByPatron)
•     Fine-List(ByTeacher&Patron)
•     Item-List(All-ByTitle)
•     Item-List(All-ByTitleWithCondition)
•     Item-List(ByPubDateForSelectedLocation)
•     Item-List(Deleted-All)
•     Loan-List(ByGrade&Patron)
•     Loan-List(ByHomeroom&Patron)
•     Loan-List(ByPatron)
•     Loan-List(ByTeacher&Patron)
•     Patron-List(All)-School
•     Patron-List(ByGrade)
•     Patron-List(ByHomeroom)
•     Stats-Circulation(Item)
•     Stats-Circulation(Patron-All)
•     Stats-Circulation(Patron-ByGrade)
•     Stats-Circulation(Patron-ByHomeroom)
•     Stats-Circulation(Patron-ByTeacher
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Contacts & Credits
 

POSTAL ADDRESS
Mandarin Library Automation, Inc.
P.O. Box 272308
Boca Raton, FL 33427-2308
 
PHONES AND FAX
(800) 426-7477 Toll-free
(561) 995-4010 Local
(561) 995-4065 Fax
 
REGULAR OFFICE HOURS
M-F 8:30AM - 5:00PM EST
 
TECHNICAL SUPPORT HOURS
24x7x365 - 24 hours/day, 7 days/week
 
BY EMAIL
Sales & Marketing: automation@mlasolutions.com
Customer Service: automation@mlasolutions.com
Technical Support: support@mlasolutions.com
Webmaster: webmaster@mlasolutions.com
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